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ABSTRACT 

 

 

Carbon fibers are now becoming a technologically and commercially 

important material in various fields such as aerospace, military, turbine blades, 

construction, medical, automotive, sporting goods industries and even for the 

application in the electronics industry. In this project, the effect of the fiber 

orientations on the thermal behavior of the carbon fiber composite by using Finite 

Element Analysis (FEA) has been studied. With the analysis, the thermal behavior of 

the composite like temperature distribution and thermal gradient have been 

evaluated.The model and the thermal analysis of carbon fiber composite are 

developed by using ANSYS Mechanical APDL. Thermal conductivity, convective 

heat transfer and heat source are the important element in thermal analysis. The 

temperature distributions show that the thermal conductivity in the perpendicular 

direction is lower than that in parallel direction.  
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CHAPTER 1 

INTRODUCTION 

 

1.1. BACKGROUND 

Carbon fibers have been studied scientifically since the late 1950s and 

fabricated industrially since 1963. Nowadays, carbon fibers are becoming a 

technologically and commercially important material in various fields such as 

aerospace, military, turbine blades, construction, medical, automotive, sporting 

goods industries and even for the application in the electronics industry. The carbon 

fiber industry has been growing steadily to meet the demand from these industries. 

According to Morinobu Endo and M. S. Dresselhaus [1] from Shinshu University, 

Japan, the world carbon fiber market now has grown to about 12 000 tons/year of 

product, after 40 years of development and this number is estimated to keep on 

growing.  

Carbon fibers are defined as one-dimensional filamentary form of carbon 

with an aspect ratio (length/diameter) greater than 100. Carbon fiber is basically a 

very thin strand of carbon, even thinner than human hair. According to Huang [2], 

carbon fibers contain at least 92 wt % carbon. Carbon fibers usually have excellent 

tensile properties, low densities, high thermal and chemical stabilities in the absence 

of oxidizing agents, good thermal and electrical conductivities, and outstanding creep 

resistance.  

Carbon fibers have been used in composite in the form of woven textile, 

continuous fibers/rovings and also chopped fibers. The composite parts can be 

produced through several methods such as filament winding, tape winding, 

pultrusion, compression molding, liquid molding and injection molding. For 

example, in automotive industry, Huang (2009) pointed out that fiber reinforced 
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polymeric composites “offer reduced weight and superior styling.” Carbon fibers are 

used in body parts, chassis and suspension system, drive shaft and so on.  

For this project, the type of carbon fiber used was a polymer-matrix 

composite. Deborah D. L. Chung [3]stated that polymer-matrix are much easier to be 

fabricated compared to metal-matrix, carbon-matrix or ceramic-matrix composite. 

This is because polymer-matrix composite only require a relatively low processing 

temperature to be manufactured.  

Thermosets, especially epoxy have long been used as polymer matrices for 

carbon fiber composites. Trade names for epoxy include Epon, Epi-rez and Araldite 

[3]. Epoxy has an excellent combination of mechanical properties and corrosion 

resistance, dimensionally stable and demonstrates good adhesion and is relatively 

affordable. Additionally, the low molecular weight of uncured epoxide resins in the 

liquid state results in remarkably high molecular mobility during processing. This 

mobility enables the resins to quickly wet the surface of the carbon fibers. 

Carbon fiber composite exhibits very excellent mechanical properties. The 

specific strength (strength/weight) and modulus (stiffness/weight) of carbon fiber 

composites show the highest value for all engineering materials. This composite has 

density that is 40% lower than aluminum and stiffer than titanium.Other attractive 

properties of carbon fiber composites include a good fatigue and creep resistance, 

low friction coefficient that results in a good wear resistance, low electrical 

resistivity and high thermal conductivity. These are the factors why carbon fibers are 

chosen in some application over other materials.  
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1.2. PROBLEM STATEMENT 

Carbon fiber composites are widely used in modern industries due to the 

unique mechanical, thermal and electrical properties. Due to the acceptable 

performance at elevated temperature, the carbon fiber composites are also involved 

in the design of hot structures like space shuttle, nozzles, turbines, hyper plane and 

others. 

From the research and literature review done, there is no thermal analysis 

done on the fiber orientation of the carbon fiber composites. Thus, in this projectthe 

thermal analysis of the carbon fiber composites will be conducted by varying the 

orientation of the fiber. The effect of the fiber orientations on the thermal behavior of 

the carbon fiber composite by using Finite Element Analysis (FEA) will be analysed. 

 

1.3. OBJECTIVES 

The main purpose of this project is to develop a 3D thermal analysis of 

carbon fiber composite structure using Finite Element Method. With the analysis, the 

thermal behavior of the composite like temperature distribution and thermal gradient 

will be evaluated. 

 

1.4. SCOPE OF STUDY 

This project will be focused on the modeling of the 3D solid structure of the 

carbon fiber composite by using Finite Element Method, which is ANSYS software. 

By using the ANSYS software, thermal load effect is analysed and thethermal 

behaviors are determined.  
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CHAPTER 2 

LITERATURE REVIEW 

 

2.1. THERMAL ANALYSIS 

Thermal load is described as the temperature that affects the structures, such 

as outdoor air temperature, solar radiation, underground temperature, indoor air 

temperature and the heat source equipment around the structures. The change of the 

temperature in the structural and non-structural member causes thermal stress and is 

defined as the effect of thermal load. 

According to wiseGEEK.com, thermal analysis is the study of the change of 

temperature within the properties of materials. A number of different properties can 

be studied using this method including mass, dimension, volume, stiffness, damping, 

heat transfer and temperature. Other concepts can be employed within the method as 

well. The main purpose of the entire discipline is to find how temperature impacts 

other aspects of physics of the materials. D. D. L. Chung [4] stated that thermal 

analysis can provide information on structural transitions, specific heat, coefficient of 

thermal expansion (CTE), process kinetics, thermal stability and composition. 

Kumar et al. [5] stated that the deflection and stresses in a composite 

structure can be brought to the allowable limits by arriving at the suitable design 

variables such as layer thickness, fiber orientation and area of cross section. 

However, it is not possible to bring down the thermal stresses induced in the 

structure due to the thermal loads, as these stresses are almost insensitive to the 

changes in the design variables. When both the mechanical and thermal loads are 

acting together on the composite, the situation may be very critical against the safety 

of the design. As these structures are exposed to hot working environment, thermal 

analysis is required for the structural integrity assessment and to precisely consider 

the effect of temperature change. 
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There are various methods of thermal analysis of a material including 

experimental approach, computational modeling and theoretical formulation. 

Computational modeling has emerged as a very informative and cost effective tool 

for materials design and analysis thanks to the advent of powerful computers and 

software. According to Srinivas et al. [6], modeling often can eliminate costly 

experiments and provide more information than that obtained experimentally.   

Kumar et al. [5] found that one of the major input data in a thermo-

structural analysis is the temperature distribution throughout the structure and its 

variation with time for the entire range of operation. A numerical approach available 

for thermal analysis is finite element method. Finite element method is used to model 

complex geometry, its changes with appropriate boundary conditions and load. The 

team studied the behavior of the composite material under thermal, thermo-chemical 

and mechanical loads. Thermo-structural analysis showed that thermal stresses are 

very much predominant when compared to stresses due to mechanical loads. 

Kiran Puttaswamy and Gabriel H. Loh [7] used a thermal simulation tool 

called HotSpot 3.0 from the University of Virginia for the thermal simulation of 3D 

die-stacked microprocessor. The modeling, simulation and analysis are primary done 

by using the software. HotSpot takes the power trace data, the configuration 

parameters and the layer parameters and generates the steady state temperatures for 

various functional blocks. 

There are numerous approaches for thermal analysis. An approach is chosen 

based on the type of material, the parameter, the input and output and whether the 

method is appropriate or possible to be carried out or not. 

 

2.2. FINITE ELEMENT ANALYSIS (FEA) 

Finite element analysis has become familiar in recent year, and is now the 

basis of multibillion dollars per year industry. Using FEA, a numerical solution to 

even very complicated stress problems can be obtained [8]. According to David 

Roylance [9], finite element codes are less complicated than many of the word 

processing and spreadsheet packages found on modern microcomputers. 

Nevertheless, they are complex enough that most users do not find it easy to program 
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their own codes. One of the FEA’s principal advantages is that many problem types 

can be adopted with the same code, merely by specifying the appropriate element 

types from the library.  

According to Roylance [9], in practice, a finite element analysis usually 

consists of three principle steps: 

i. Preprocessing: The construction of a model of the part to be analysed. The 

geometry is divided into a number of discrete subregions, or “elements”, 

connected at discrete points called “nodes”.   

ii. Analysis: The dataset prepared by the preprocessor is used as input to the 

finite element code itself, which constructs and solves a system of linear or 

nonlinear algebraic equations. Commercial codes may have very large 

element libraries, with elements appropriate to a wide range of problem 

types.  

iii. Post-processing: A typical postprocessor display overlays colored contours 

representing stress levels on the model, showing a full-field picture similar 

to that of photo elastic or experimental results. 

Most of the practical problems are solved by numerical methods, which 

provide approximate but acceptable solution. The approach that is used by Wu, Zeng 

and Feng from Xihua University [10] to analyse the thermal load of piston are first, 

to discretize the piston into limited number of cells which are connected to each 

other by nodes, then to build the functions of cells based on that. The function is then 

combined to obtain the temperature formula of the entire structure’s functional. 

Secondly, is by seeking the extremum of the functions, the linear equations can be 

built. By solving the equations, the temperature of the structure nodes can be 

obtained. Finally, temperatures of all the nodes can determine the temperature field 

of the whole piston. By entering the geometry model and corresponding heat 

boundary condition in ANSYS software, the temperature field of the piston is 

obtained. The heat boundary condition application approach by Wu, Zeng and Feng 

was used as a reference to develop a new heat boundary condition for this project. 

A hybrid FEA model was introduced by Sidhu and Averii [11] to simulate 

textile composite material in stamping process. Li and Sherwood [12] modified this 

approach for the simulation of woven commingled glass-polypropylene composite 
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fabrics and compared the result of the simulation with experiment on the real 

material.  

The approaches by Sidhu and Averii and Li and Sherwood were then further 

developed by Barschke and Uribe [13] to simulate the composite materials using 

kinematic constraints. Barschke and Uribe study gave the basic idea to develop the 

composite model discussed in this project. 

ANSYS is a commercial Finite Element Method (FEM) package having the 

capabilities ranging from a simple, linear, static analysis to a complex, nonlinear, 

transient dynamic analysis. It is available in modules. Each module is applicable to 

specific problem. For example, Ansys/Civil is applicable to Civil structural analysis. 

Modeling is the important step of creating the physical object in the system. There 

are two types of modeling in ANSYS, which are direct modeling and solid modeling 

[14].  

 

2.3. THERMAL ANALYSIS OF CARBON FIBER COMPOSITE 

Various techniques have been developed by the researchers to evaluate the 

thermal effect on the carbon fiber composite. A method used by D. D. L Chung [4], 

which has received relatively little attention involves measurement of the electrical 

resistance as a function of temperature. The thermal analysis conducted on the 

carbon fiber polymer-matrix structural composites by DC electrical resistance 

measurement provides information on structural transitions, residual stress, 

composite interfaces, the composite fabrication process and thermal damage. The 

composites involve continuous carbon fibers in single fiber and laminate forms, 

together with thermoplastic and thermoset matrices. This technique involves 

measuring the DC electrical resistance when the polymer has been reinforced with 

electrically conducting fibers such as continuous carbon fibers. The resistance is in 

the fiber direction. The resistance change indicates the glass transition and melting 

behavior. The electrical resistance provides an indication of the thermal stress.  

Other than that, a coupled thermal-electrical analysis of carbon fiber 

reinforced polymer composites (CFRP) exposed to stimulated lightning current was 

conducted by Toshio Ogasawara, Yoshiyasu Hirano and Akinori Yoshimura [15] 
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from Japan Aerospace Exploration Agency. Thermal and electrical properties of 

CFRP are evaluated for each direction of the unidirectional composites using FEA. 

The team conducted the analysis by using commercial FEA software, Abaqus ver 

6.8. Based on the experimental results and a preliminary analysis, the specific 

mechanism of electrical conduction through the thickness direction of CFRP 

composite following thermal decomposition was revealed to be a key parameter 

foraccurate numerical simulation. The delamination area and damage depth were 

estimated from numerical results and thermal decomposition behavior of CFRP 

composite with the estimated damage area agreeing qualitatively with the 

experimental results. 

Harri Katajisto, Timo Brander and Markus Wallin [16] from Helsinki 

University of Technology carried out a structural and thermal analysis of carbon 

composite electronics housing for satellite. The purpose of the study was to design, 

manufacture and test a composite housing that meets the structural and thermal 

requirements of an existing equipment unit (aluminium housing). The problem was 

analyzed with FEA software ANSYS using solid elements. Only conduction was 

considered.The analysis results demonstrated that single-layer elements were 

adequate for thin laminates in steady state. In the thermal point of view the concept is 

promising and the behavior of the structure was well predicted with the analysis 

tools. 

From the literature review discussed above, most of the thermal analyses 

done are using the experimental approach and there is no analysis done on the fiber 

orientations of the composite. 
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CHAPTER 3 

METHODOLOGY 

3.1. PROJECT FLOW CHART 

 

Figure 3.1:Project Flow Chart 

The project flow chart is shown in Figure 3.1. Research is done by 

performing a literature review on the journals and articles related to the project. The 

scope of study for the project is also established by conducting the research. Data 

collection is very important, as all the gathered information is needed for further 

analysis. In model development, the problem is modeled by using ANSYS software. 

After that, a data analysis is done by entering the input or parameter on the 

composites model in ANSYS. After thermal analysis is performed on the model, 

dataverification took place. Verification is done to validate the simulated result with 

theoretical values.  

 

• Research on journal related to the project 

• Scope of study for the project is established 
Literature Review 

• Understand the concept of thermal analysis 

• Familiarise with FEA concept and ANSYS 
Learning 

• Gather data on carbon fiber composite 

• Modelling technique of composites 
Data collection 

• Develop the model using ANSYS Model Development 

• Enter heat boundary condition/parameter in 
ANSYS 

• Perform thermal analysis  
Data Analysis 

• To validate the result with theoretical values Data Verification 
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3.2. THERMAL ANALYSIS 

 3.2.1 Building the Model 

The first step of a thermal analysis is to develop the model [17]. For 

this project, the carbon fiber composite model is developed by using 

ANSYS Mechanical APDL. 

 

  

 

 

 

 

 

 

 

 

The steps involved in building the model is shown in Figure 3.2. Once 

the geometry of the model is decided, each element in the layered model is 

defined [18]. After that, the element material properties are assigned to the 

model. Lastly, meshing is applied to the model by defining the mesh size 

and area. 

3.2.2 Assigning Load and Solving 

After the model is complete, the next step is to apply the load and 

solve the system.  The steps in assigning load and solving is presented in 

Figure 3.3. First, the analysis type of the system is defined to be as a steady 

state or transient. In this system, one side of the composite has fixed 

temperature, while convection occurs on the other 2 sides. Conduction 

Create geometry 

•Layered element 

Define the type of element 

•Fiber orientation 
•Matrix 

Assign the element 
material properties 

•Thermal conductivity 

Mesh 

Figure 3.2:  Steps in Building the Model 
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constraint, convection boundary conditions and insulated boundary 

conditions are applied to the system before the system is solved. For steady 

state and transient, the steps involved are different which will be further 

discussed in Section 3.4. 

 

Figure 3.3:  Steps in Applying the Loads and Solving 

 

3.2.3 Review of the Result 

The last step in thermal analysis using ANSYS is to plot the results. 

The results are generated by using a temperature plot. A temperature 

distribution graph is obtained and critical conditions such as maximum 

temperature gradient and maximum temperature can be determined. 

 

Define Analysis Type 

•Steady-state 
•Transient 

Apply Conduction 
Constraints 

•Thermal temperature on 
lines 

Apply Convection 
Boundary Conditions 

•Uniform convection across 
the line 

Apply Insulated 
Boundary Conditions 

•Constant Film coefficient of 0 

Solve the System 
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3.3. MODEL DEVELOPMENT OF CARBON FIBER COMPOSITES 

 3.3.1 The Material 

The analysed material is a woven carbon fiber reinforced composite 

material with a uniform number of warp and filling threads [13]. An epoxy 

resin was used as matrix. In order to simplify the problem, a linear Young’s 

modulus behavior was chosen for the epoxy resin. The woven structure is 

shown in Figure 3.4. 

 

 

 

 

 

The mechanical properties of the carbon fiber and epoxy resin 

materials are shown in Table 3.1. The Young’s modulus and the tensile 

strength of carbon fiber are higher than the epoxy resin. 

 

Table 3.1:  Mechanical Properties of the Material [19] 

 
Young’s Modulus Poisson’s Ratio Tensile Strength 

Fiber 230000 N/mm
2
 0.3 3500 N/mm

2
 

Resin 3000 N/mm
2
 0.3 80 N/mm

2
 

 

From homogenization technique developed by Zhao and Weng [21], 

the elastic modulus of carbon fiber reinforced polymer (CFRP) composite 

changes as the volume fraction of the matrix and fiber changes.  

 

 

Finite Element Modeling of Composite Materials using K inemat ic Const raints

Figur e 1: The Woven Structure of the Material

i) The plane fiber approach

ii) The woven fiber approach

3.2.1 T he Plane Fiber A pproach. The main object ive while developing

the first model of the material is to keep the model at a low level of geometric

complexity. The plane fiber approach (i) uses ANSYS LINK8 elements to

simulate the fibers and SHELL91 elements to simulate the matrix.

In this approach a rigid connect ions between the orthogonal fibers are

established, due to the fact that the vert ical and horizontal LINK8 elements

use the same nodes. To obtain the correct mass of resin without affect ing its

moment of inert ia, the matrix is modeled in two SHELL63 layers with thefiber

in between. In order to connect the two layers of the resin and the fiber layer,

each node of the fiber layer is coupled in each DOF with the corresponding

nodes of the upper and the lower fiber layer (fig. 2).

3.2.2 T he Woven Fiber A pproach. The woven fiber model (ii) is created

in order to simulate a more elaborated model which is much closer to reality.

Especially the effect of non-rigid connect ions between the orthogonal fibers, as

well as theeffect of thecurled fiber is to beanalyzed here. Thewoven approach

is to be used as a reference model to figure out whether the simplificat ions

made in the plane approach affect the results of st ress and strain significant ly.

|140 I ngenier ía y C iencia, ISSN 1794–9165

Figure 3.4:  The Woven Structure of Carbon Fiber 
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Table 3.2:  Elastic Modulus of CFRP Composite Determined Using Homogenization 

Technique [20] 

Epoxy matrix 

volume fraction 

Carbon fiber 

volume fraction 

Composite elastic 

modulus (E) (MPa) 

0.8 0.2 48,577 

0.825 0.175 42,899 

0.85 0.15 37,222 

0.875 0.125 31,545 

0.9 0.1 25,868 

Note: Homogenization techniques proposed by Zhao and Weng. 

[21] 

Deborah D.L. Chung [3] studied the thermal conductivity of 

different carbon fiber composites. These investigations are to be used to 

integrate the thermal behavior in the models introduced in this project. 

However, structural analysis and thermal analysis are two different 

analyses. The mechanical properties are not included in a thermal analysis. 

In thermal analysis only three factors are considered; 

i. Thermal conductivity, k 

ii. Heat flux vector (Convective), h 

iii. Heat source, T 

Thermal conductivity is the ability of a material to conduct heat. 

Heat transfer across materials of high thermal conductivity happens at a 

higher rate than across materials of low thermal conductivity. In other words 

materials with high conductivity conduct heat better than materials with 

high thermal resistivity which are used as thermal insulators. 

Heat flux vector is the rate of heat energy transfer through a given 

surface by a movement of fluid such as air or water, which is also known as 

convective heat transfer. 

3.3.2 Thermal Properties of Carbon Fiber Composite: 

The thermal conductivity of carbon fiber and epoxy are listed in 

Table 3.3.  
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Table 3.3:  Thermal Conductivity of Carbon Fiber Composite [22] 

Material 
Thermal Conductivity 

(W/m*K) 

Density 

(g/cm
3
) 

Carbon Fiber 24 1.78 

Epoxy 0.5 1.11 

The model is simulated under a low speed of air movement over the 

surface. The value of the convective heat transfer for this case is fixed to be 

10 W/m
2
K [23]. 

 

 3.3.3 The Plane Fiber Approach 

The way of modeling the woven fiber reinforced material is developed 

using the FEA software, ANSYS. A detailed steps on the composite 

modeling is discussed in Section 3.4. 

A plane fiber approach was chosen to keep the model at a low level of 

geometric complexity. In this approach, a thermal mass ANSYS SHELL131 

element was used to stimulate the fibers and the matrix. Only ANSYS 

SHELL131 can be used to model the layered composites. The matrix is 

modeled in two SHELL131 layers with the fiber in between. The fiber layer 

and the matrix layers are considered to be in connection since they share the 

same node in each degree of freedom (DOF) as shown in Figure 3.5. 

 

 

 

Figure 3.5:  The Plane Fiber Approach 
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3.3.4 The ANSYS Elements 

Shell131 (lower-order) is a 3D layered shell element having in-plane 

and through-thickness thermal conduction capability. This element has four 

nodes with up to 32 temperature degrees of freedom at each node. The 

conducting shell element is applicable to a 3-D, steady-state or transient 

thermal analysis [13].  
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3.4. THERMAL ANALYSIS IN ANSYS 

ANSYS 14.0 was employed to solve steady-stateand transient thermal 

problem. The mixed Convection/Conduction/Insulated Boundary Conditions were 

imposed as shown in Figure 3.6. 

 

 

 

 

 

 

 

 

A constant temperature of 100 °C was applied on the top line of the model. 

Both sides of the composite are subjected to convection heat transfer of 10 

W/m
2
*K with an insulated bottom.  

 

3.4.1 Preprocessing: Defining the Model 

1. Define the Preferences 

 Preferences > Thermal 

 

Figure 3.6 The boundary condition of the model 

Figure 3.6:  The boundary condition of the model 



 24 

2. Define the Element Type 

 Preprocessor > Element Type > Add/Edit/Delete... > click 'Add' > 

Thermal Mass Shell, 3D 4node 131 

 

 

 

 

 

 

3. Element Material Properties 

 Preprocessor > Material Props > Material Models > Thermal > 

Conductivity > Isotropic > KXX = 24 

 

 KXX = 24 is for carbon fiber thermal conductivity, while KXX = 0.1 

is for epoxy thermal conductivity. 

4. Develop Layered Model 

 Preprocessor > Sections > Shell > Lay-up > Add/Edit 
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All the corresponding value is inserted. The thickness of each layer is 0.03 m. 

The material ID and orientation of each of the layers can also be defined in 

this section. 

5. Create the Geometry 

 Preprocessor > Modeling > Create > Areas> Rectangle > By 2 Corners > 

X = 0, Y= 0, Width = 1, Height = 1 

6. Mesh 

 Preprocessor > Meshing > Mesh > Areas > Free > Pick All 

The model should look as in Figure 3.7. 

 

 

 

 

 

 

 

 

 

Figure 3.7:  The meshed model of carbon fiber composite 
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3.4.2 Solution Phase: Assigning Loads and Solving 

3.4.2.1 Steady State Thermal Analysis 

A steady-state thermal analysis calculates the effects of steady thermal 

loads on a system or component. Steady state thermal analysis is often performed 

before performing transient thermal analysis to help establish initial conditions 

[24].  

The procedures are: 

1. Define Analysis Type  

 Solution > Analysis Type > New Analysis > Steady-State  

 

2. Apply Conduction Constraints  

 In this analysis, the top part of the composite has fixed temperature, 

while convection occurs on the other 2 sides.  

 Solution > Define Loads > Apply > Thermal > Temperature > On Lines 

The top line of the composite was constrained with a constant value of 

100 °C.   

3. Apply Convection Boundary Conditions  

 Solution > Define Loads > Apply > Thermal > Convection > On Lines  

 The right and left side of the composite is selected.   The following 

window will appear:  
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All the corresponding value is inserted. VALJ and VAL2J have been left 

blank. This is because we have uniform convection across the line. 

4. Apply Insulated Boundary Conditions 

 Solution > Define Loads > Apply > Thermal > Convection > On Lines 

Select the bottom of the block. 

 A constant Film coefficient (VALI) of 0 is assigned. This will eliminate 

convection through the side, thereby modeling an insulated wall. 

5. Solve the System 

 Solution > Solve > Current LS 

 

3.4.2.2 Transient Thermal Analysis 

Transient thermal analysis determines temperature and other thermal 

quantities that vary over time. Many heat transfer application such as nozzles, 

engine blocks, piping system and pressure vessels involve transient thermal 

analysis. 
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The transient thermal analysis procedures are: 

1. Define Analysis Type  

 Solution > Analysis Type > New Analysis > Transient 

 

A full transient solution is chosen. 

 

2. Set Solution Controls 

 Solution > Analysis Type > Sol'n Controls 

 

i. The Time at end of loadstep is set to 200 and Automatic time stepping 

is set to ON. 

ii. The Number of substeps is set to 20, Max no. of substeps is 100 and 

Min no. of substeps is 20. 

  

Solution Phase: Assigning Loads and Solving  

1. Define Analysis Type 
Solution > Analysis Type > New Analysis > Transient 
ANTYPE,4 

The window shown below will pop up. We will use the defaults, so click OK.  

 

2. Set Solution Controls 

University of Alberta ANSYS Tutorials - www.mece.ualberta.ca/tutorials/ansys/IT/TransCond/Print.html

Copyright © 2003 University of Alberta
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iii. The Frequency is set to Write every substep. 

 Move on to the NonLinear tab at the top. 

 

iv. The Line search is set to ON. 

v. The Maximum number of iterations is set to 100. 

Basically, the time at the end of the load step is how long the transient 

analysis will run and the number of substeps defines how the load is broken 

up. 

3. Apply Constrain 

 Solution > Define Loads > Apply >Thermal > Temperature > On Nodes 

 Solution > Define Loads > Apply > Thermal > Convection > On Nodes 

4. Apply Initial Conditions 

 Solution > Define Loads > Apply > Initial Condit'n > Define > Pick All 

 

 

 

 

 

 



 30 

The initial temperature of the composite is 27 °C. 

5. Solve the System 

 Solution > Solve > Current LS 

 

3.4.3 Postprocessing: Viewing the Results 

1. Results Using ANSYS 

 General Postproc > Plot Results > Contour Plot > Nodal Solu ... > 

DOF solution, Temperature 

 General Postproc > Plot Results > Contour Plot > Nodal Solu ... > 

DOF solution, Thermal gradient 
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3.5. GANTT CHART AND KEY MILESTONES 

Figure 3.8 Project Gantt Chart and Milestone 

Figure 3.8 shows the progress of the project. The project is divided into two, 

which are Final Year Project 1 (FYP1) and Final Year Project 2 (FYP2). During 

FYP1, the author planned to finish the model development and starts FYP2 with 

data analysis.  

 

3.6. TOOLS AND EQUIPMENT 

 ANSYS Mechanical APDL software – modeling of the problem and analysis 

 Microsoft Excel – data gathering and analysis 

 Microsoft Word – report writing 
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CHAPTER 4 

RESULTS AND DISCUSSIONS 

4.1. RESULTS 

 

 

 

 

 

 

 

 

 

 

Figure 4.1 above shows the layered model of the composite that has been 

developed using ANSYS. The model consists of 3 layers, where the fiber layer in 

the middle is sandwiched by two layers of epoxy.  

The orientation of fiber is manipulated in lay-up properties of the model. The 

angles chosen for the study are +40/-45 degrees, 0 degree and 90 degrees. These are 

the commonly used orientation of the composites. 

 

 

Figure 4.1:  The Layered Model of Carbon Fiber Composite 
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4.1.1 Thermal Behaviors 

4.1.1.1 Steady State Thermal Analysis 

The temperature distribution of the steady state analysis of the carbon 

fiber composite is observed and evaluated for its thermal behavior. Each fiber 

orientation yielded a slightly different temperature distribution. 

First, the thermal analysis is done on the carbon fiber and epoxy resin 

alone. The temperature distribution of carbon fiber is shown in Figure 4.2 and 

epoxy resin is in Figure 4.3. The analysis is done on each material separately 

as a reference to the composite analysis. So that, the behavior of the 

composite can be determined. 

 

 

 

 

 

 

 

 

 

 

Figure 4.3:  The temperature Distribution of Epoxy 

 

Figure 4.2:  The temperature Distribution of Carbon Fiber 
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1. 0° Fiber Orientation 

 

 

 

 

 

 

 

 

 

The temperature distribution for the 0 degree fiber orientation of the 

carbon fiber composite is shown in Figure 4.4. The maximum temperature 

will always be the source of heat, which is 100 °C or 373 K. The temperature 

propagated from the maximum applied temperature on the top part through 

the composite to the insulated bottom part. The minimum temperature of the 

composite is recorded to be 303.8 K or 30.8 °C, 3.8 °C higher than the 

applied surrounding temperature (27 °C).  

The 0° fiber orientation is said to be in parallel with the epoxy. 

Deborah D.L Chung [3] said that the thermal conductivity of carbon fiber 

composite with a parallel direction of fiber is higher than perpendicular 

direction. In this case, the higher thermal conductivity in the composite is 

provided by the carbon fiber. Thus, the temperature distribution reveals that 

the composite takes on the behavior of a higher thermal conductivity which is 

carbon fiber. This explains why the temperature distribution of the 

0°composite is slightly similar to the carbon fiber. 

 

Figure 4.4: Temperature Distribution for 0° Fiber Orientation 
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2. 45° Fiber Orientation 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.5:  Temperature Distribution for 45° Fiber Orientation (top and bottom layer) 

Figure 4.6:  Temperature Distribution for 45° Fiber Orientation (middle layer) 
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For 45° fiber orientation, the analysis yielded two different 

temperature distribution of the composite. Figure 4.5 shows the temperature 

distribution for the 45° fiber orientation at the top and bottom layer of the 

carbon fiber composites and Figure 4.6 shows the temperature distribution for 

the 45° fiber orientation at the middle layer.  

In structural point of view, at 45° orientation, the composite is said to 

be more flexible and has high torsional strength [25]. However, the structural 

properties cannot be implemented in thermal analysis. 

The top and bottom layer temperature distribution in Figure 4.5 

demonstrates a pattern that is almost similar to the temperature distribution of 

epoxy but with a better heat dispersion. The minimum temperature is 301.2 K 

or 28.2 °C which is 1.2 °C higher than minimum temperature of epoxy. The 

middle layer temperature distribution in Figure 4.6 has a quite similar pattern 

to the temperature distribution of carbon fiber. The minimum temperature is 

303.8 K or 30.8 °C.  

In this orientation, the composite somehow do not bond together to 

form one solid element or composite. This could be the reason why the 

analysis came out with two different temperature distributions. The thermal 

analysis for the 45° orientation can be concluded as inaccurate. A correct 

model should be able to behave as one solid element and come out with only 

one temperature distribution. However, in this case, the 45° orientation model 

yielded two different temperature distributions. 
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3. 90° Fiber Orientation 

 

 

 

 

 

 

 

 

 

 

 

The temperature distribution for 90 degree fiber orientation of the 

carbon fiber composite is shown in Figure 4.7. The maximum temperature is 

of course the applied temperature, 100 °C. The minimum temperature is 

301.2 K or 28.2 °C which is slightly higher than the surrounding temperature.  

Deborah D. L. Chung [3] stated that the thermal conductivity of four 

different carbon fiber composite in perpendicular orientation having the same 

epoxy resin are the similar. Therefore, in perpendicular orientation (90°), the 

thermal conductivity of the composite is dominated by the epoxy matrix. 

However, the temperature distribution does not resemble exactly like epoxy 

because the heat dispersion of the composite is better.  

 

Figure 4.7:  Temperature Distribution for 90° Fiber Orientation 
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4.1.1.2 Transient Thermal Analysis 

The transient thermal analysis yielded the same result as the steady 

state thermal analysis. The temperature distribution of the composite by 

transient analysis is summarized in Table 4.1. 

Table 4.1:  Temperature Distribution of Carbon Fiber Composite by Transient 

Analysis 

Degree (°) Temperature Distribution 

0 

 

45 

Top and bottom layer.
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Middle layer. 

 

90 

 

 

The thermal behavior of the carbon fiber composite does not vary in 

transient analysis and steady state analysis. Carbon fiber composite also has a 

dimensional stability property which allow zero coefficient of thermal 

expansion, making it as a very suitable and stable material to be used at 

elevated temperature. 
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4.1.1 Thermal Gradient 

Thermal gradient is a physical quantity that describes in which direction and 

at what rate the temperature changes the most rapidly around a particular location. 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

Figure 4.8 show the thermal gradient of the composite. The thermal gradient 

in all the degree of the fiber orientation is the same. The temperature changes the 

most rapidly at the both top left and right side of the epoxy layer with a rate of 

727.2 Kelvin per meter. This shows that a surface that is exposed to convection 

changes temperature faster. However, the convection does not give much effect 

on the carbon fiber layer. 

Figure 4.8:  Thermal Gradient Of Carbon Fiber Composite 
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CHAPTER 5 

CONCLUSION AND RECOMMENDATION 

5.1. CONCLUSION 

The main purpose of this project is to develop a 3D thermal analysis of 

carbon fiber composite using Finite Element Analysis to estimate its thermal 

behavior from the temperature distribution and thermal gradient. The 3D thermal 

analysis has been successfully developed by using ANSYS. Consecutively, the 

analysis on the temperature distribution and thermal gradient is done to estimate the 

thermal behavior of the composite. All the objectives are relevant and achievable 

throughout this project. 

The thermal conductivity of the composite in perpendicular direction is 

lower compared than that in parallel direction because its property is dominated by 

the epoxy resin. The composite can be designed to exhibit higher thermal 

conductivity by setting the fiber orientation in parallel direction (0°).  

5.2. RECOMMENDATION 

Throughout this project, author has faced a few difficulties to come out with 

the analysis on composite.There are some areas that need to be fixed and improved. 

The author has come up with two recommendations in order to enhance the 

outcome of this project. 

Firstly, an ANSYS Composite Preppost (ACP) can be used to replace the 

ANSYS Mechanical APDL to do the analysis on composite. ACP provides all 

necessary functionalities for the analysis of layered composite structures. The 

author believes that more accurate analysis can be done by using ACP. 

Other than that, experimental approach should be implemented to support 

the result of the simulation done. The outcome of the experiment can be used to 

validate and compare the analysis done using the software. 
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